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1 Introduction
Welcome to MC Next! This manual is a comprehensive guide of the MC Next
Easy-To-Use environment and features to get you started using the product right
away.

What is the MC Next software?
MC Next software is your link between the construction site and the office. It
facilitates the exchange of data between your CAD software and the total station.
The MC Next software supports Revit and AutoCAD software, including AutoCAD
LT and BricsCAD. To prepare points in a CAD drawing for setting-out purposes,
simply launch your CAD program from within the MC Next software environment.
The MC Next functionality is automatically added to your CAD program. All of the
CAD programs have the same workflow and functionality, whether you are working
with, for example, AutoCAD LT or BricsCAD, so you can work right away.
In addition, the MC Next software allows you to import data from or export data to
your Total Station, or a range of other external devices. You can also import from
and export to a variety of file formats, enabling you to build, manage, and organize
your projects with a minimum of time.

Related information
Sources of related information include the following:


Help - The MC Next software has built-in help that lets you quickly find the
information you need. Access it from the Help menu. Alternatively, click the
? button in a dialog, or press [F1].

Technical support
If you have a problem and cannot find the information you need in the product
documentation, please contact your local dealer. Alternatively, you can go to the
Support area of the MOUS Software website (www.moussoftware.com). Select the
product you need information on. Product updates, documentation, and any support
issues are available for download.
If you need to contact MOUS Software, please email support@moussoftware.com
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Your comments
Your feedback about the supporting documentation helps us to improve it with each
revision. Email your comments to info@moussoftware.com.
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2 Installing the Software
This chapter describes how to install the MC Next software on your computer.

System Requirements
Before you install the product, you should make sure that your computer meets the
minimum system requirements.


Microsoft® Windows® XP, Windows Vista, Windows 7, Windows 8 or
Windows 10 (32- and 64-bit versions)



Administrative Privileges on the system



Pentium Dual-core 1.80 GHz or better recommended



1 GB RAM or more recommended



250 MB of disk space required



1024 x 768 or higher resolution with 256 or more colors (at 96 DPI)



Keyboard and Mouse or other pointing device



USB port

Installing the MC Next Software
Choose a location on your computer to store the executable program, then save and
run the .exe file.
Now follow the instructions in the Setup wizard.

Installing the hardware security device
When the MC Next Software is installed on your computer, a setup installshield
wizard will automatically start to install the hardware security device.
After the security device drivers have been successfully installed, your system will
recognize the security device to the USB port.
Note – The hardware security device is an essential and extremely valuable part of
the software. The key effectively provides the license to use the software and as such
the replacement cost is equal to the cost of another set of software.
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Note - A file named README.TXT may be along the files copied. Be sure to read
this file if available. It contains information about MC Next that was not included in
this manual at the time of print.
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3 A tour of the environment
Starting the software
The best way to get familiar with MC Next is to start it up. You start MC Next the
same way you start any Windows-based application. Here are some of the common
ways:


Double-click on the MC Next icon on your desktop.



From the Windows Start menu, choose Programs | MC Next.

The Welcome screen provides access to the most commonly used features:

Ribbon
The MC Next Ribbon, located in the main window, organizes tools in logical
groupings.
The ribbon is composed of a series of tabs, which are organized into panels. Some
ribbon panels provide access to a dialog box related to that panel. To display the
related dialog box, click the dialog box launcher denoted by an arrow icon, , in the
lower-right corner of the panel.
To find out what any button does, point to it for a moment and a hint is displayed.
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Working with the database
The main window shows your data, and provides data editing and viewing
capabilities that allow you to maintain the integrity of your data.
You can modify point numbers, as well as insert and delete points. Additional
functionality, such as cut, copy, and paste are also provided.
Data views

The main window provides easy access to two separate views of your points:
 ListView shows the points in a list and lets you select and edit items.

 GraphicView shows a graphical overview of the points and lets you zoom and
select items easily.

When you make changes to data in one view, the changes are reflected in the other
view.
MC Next Software Getting Started Guide
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Setting general options
To change general settings for the software, select Settings from the Ribbon Quick
Access Toolbar. The Settings dialog appears:

Language setting

To select another language for the MC Next software, select it from the Language
drop-down list.
Project Location

The Project Location field defines the default folder for new projects. To select a
different location, click the Browse button
and then navigate to the folder.
Note - When you change the project location, you are not moving the folders and
files that you had already created under the previous project location. To change
the location of existing folders and files, you must save the project with a new name
or move the folders yourself.
Units

Select the Units tab to select the unit formats for values that the MC Next software
displays and outputs. You can define settings for the following units: Coordinate
order, Angle, Distance, Temperature, Pressure.
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CAD / BIM Program

To select the CAD / BIM program to use with the MC Next software, select the
CAD / BIM Program tab . To add a CAD / BIM program, click the Browse button
next to the Use program field and then navigate to the .exe file.
To define additional settings, click Advanced.

Setting code library
You can change the code library settings by choosing Code Library Settings from
the Ribbon Quick Access Toolbar.
The code library has been designed to allow the computer to understand and
implement codes that are defined by the user. The definition of the code includes
numerous pre-defined instructions, or features. This coding system is designed to
allow the computer to relate codes to the automatic creation of a CAD drawing.
Each code is given a description, such as Fence, Tree, Manhole, Kerb. These same
descriptive notes can be used as feature codes in the field.
In the code library there are three types of codes:


Line codes



Symbol codes



Control codes

Line codes

A line code is related specifically to a line that was observed. For example in the
standard code library there is a line code FCE that is used to define how any fence
lines that are recorded (as points) will be drawn in your CAD Program.
The line code FCE has the following features:


Code:

FCE



Description:

Fence



Layer:

FENCE



Point symbol:

PILE

You can select a layer and point symbol for this specific code from the associated
DXF template file. This DXF Template file has the same filename as the code
library and can freely be adjusted as needed.
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Symbol codes

A symbol code is related specifically to a symbol (= block) that was observed. For
example in the standard code library there is a symbol code TREE that is used to
define how any trees that are recorded (as points) will be drawn in your CAD
Program.
The symbol code TREE has the following features:


Code:

TREE



Description:

Evergreen Tree (Type 1)



Layer:

TREE



Block:

TREE_1



Block size:

2.50



Block rotation:

0



Attributes:

0

You can select a layer and block for this specific code from the associated DXF
template file and can freely be adjusted as needed. When you choose block size by
Observation and / or block rotation by Observation, then this symbol is associated
with an individual observation to a point. Some features are better described by
more than one observation point.
Control codes

A control code controls the way a line code is implemented. For example if we code
a point as FCE B, then the control code B will control the way the line code FCE is
implemented, in this case starting a fence line (B= Begin). At the moment there are
five control codes:


B (Begin a line)



E (Ends a line)



CLS (Closes a line to the first point in the sequence)



BC (Begin Curve)



EB (End Curve)

A large number of features you survey have curved lines or edges. These include
natural boundaries like stream edges and regular curves such as kerb lines at
intersections. MC Next uses one curve fitting system to cover all these cases. The
curve is always fitted through the surveyed points.
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For example if we code a point as KERB1 BC, and an end curve is not specified, then
a three-points curve is applied by default. So specifying an end curve is then not
needed. When multiple points are observed, and an end curve is specified, then the
curve will be fitted between them.
Syntax

Any point may have one or more codes assigned to it. Point codes are separated by a
space. To use a control code it must be entered immediately after the line code that
is to modify (allowing a space for separation) and only one control code at a time
can be assigned to a line code.
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Editing data
ListView shows the points in a list and lets you add, edit, or delete points.

To select a range of points, press and hold the [Shift] key and then select the points.
To add more points to the selection, press the [Ctrl] key instead of the [Shift] key.
To access shortcut commands, position the cursor over the ListView and then click
the right mouse button. A shortcut menu appears.
Editing a single point

To edit any point in the list, highlight the appropriate cell and then enter the new
information.
You can cut, copy, and paste information as required to and from the clipboard. You
can access these commands from the Ribbon at the top of the screen.
Note - The contents of the clipboard are overwritten with each cut or copy action.
To avoid losing data, perform the paste action immediately.
Editing multiple points

You can edit multiple points by pressing [Ctrl F2].
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1. Select a range of points in the ListView or GraphicView.
2. Press [Ctrl F2].
The Edit special dialog appears.

3. Make your changes and press OK.
Inserting points

Add points to the database as needed.
1. Select a point in the ListView, directly above where you want the new point
to be inserted.
2. Right-click and then select Insert Point.
The Insert point dialog appears.

3. Enter the appropriate data for the new point.
If required, you can leave the data fields empty, to be filled out at a later
time.
4. To insert the data into the database, click Insert.
5. To insert another point at the same location, repeat step 3 and step 4.
MC Next Software Getting Started Guide
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6. When you are finished inserting points at that location, click Close.
Note – To insert multiple points at different locations, it is necessary to close the
Insert dialog and move the cursor to a new insertion location.
Deleting points

You can delete a point or multiple points by selecting the points in the ListView or
GraphicView.
1. Select the points in the ListView or GraphicView
2. From the Ribbon, select Delete
A confirmation message appears.
3. Click Yes to delete the selected point(s).

Viewing data graphically
GraphicView shows a graphical overview of the points and lets you zoom and select
items easily.

Use the commands in the Zoom panel to zoom in and out or pan around your data.
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Select...

To...

Zoom Window

zoom to an area you select by drawing a rectangle in the GraphicView.

Pan

center a point in the drawng by doubleclicking the point in GraphicView.

Zoom In

increase the apparent size of items in the GraphicView.

Zoom Out

decrease the apparent size of items in the GraphicView.

Zoom Previous

display the previous view.

Zoom Extents

display the entire job.

Refresh

cancel all active commands and deselect all items.

To select a range of points, press and hold the [Shift] key and then drag a rectangle
around the points. To add more points to the selection, press the [Ctrl] key instead of
the [Shift] key.
To access shortcut commands, position the cursor over the GraphicView and then
click the right mouse button. A shortcut menu appears.
Viewing the coordinate of a point

1. From the Ribbon, click the ID Point button
2. In the GraphicView, select a point.
The Inquire Coordinate dialog appears:

3. Close the dialog, or select another point.
To select a different command, click the Refresh button

on the Ribbon.

Measuring the distance between two points

1. From the Ribbon, click the Measure Distance button

.

2. In the GraphicView, select a begin point.
MC Next Software Getting Started Guide
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3. In the GraphicView, select an end point.
The Inquire Distance dialog appears:

4. Close the dialog, or select another point.
To select a different command, click the Refresh button
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5 Communicating with Devices
The MC Next software communicates directly with devices to receive and send
files. You can also exchange files, including DXF background files with Windows
Mobile® devices.
The MC Next software accepts files from some types of device directly into the
database. The software also supports standard ASCII formats, such as comma and
tab delimited files. You can download an ASCII file from a device to your local
drive and then import it into the database.

Setting communication parameters
To set communication parameters for a total station or a mobile device:
1. From the Ribbon Quick Access Toolbar, select Device Settings.
The Communications Settings dialog appears.

2. Select the appropriate settings and then press OK.
Note – The MC Next software must be set to the same baud rate and parity
as the device for the transmission to work properly.

Receiving data from a mobile device
1. Connect the mobile device to the computer using Microsoft ActiveSync
technology. For more information on ActiveSync, refer to the
documentation for the mobile device.
MC Next Software Getting Started Guide
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2. From the Ribbon, select Import from Device.
The Import from mobile device dialog appears.

3. Click Explore or Explore Project Folder to start exchanging files.
Tip – If you copy the files to the local hard drive, you can then drag files to
the main window of MC Next to add points to the database.

Receiving data from a total station
When you receive data from a total station, the screens that appear depend on the
type of total station connected. For more information, refer to the user
documentation provided with your total station.
1. Connect the total station to the computer
2. From the Ribbon, select Import from Device.
Note – If you are working with a Trimble LM80 or NOMAD SERIE, you
can skip the following steps. MC Next presents the Import from LM80
dialog to copy files to your local hard drive. Click on the button Explore to
start exchanging files.
Note – If you are working with a Leica TC400/700 SERIE or Leica (Power)
Builder SERIE, you can skip the following steps. MC Next presents the
Receive dialog and you can exchange files by pressing the button Update
Instrument/Files (F5)
The Save Receive File dialog appears.
3. Select the path into which the file will be saved.
4. Enter a destination name for the file to be received in the File Name field.
MC Next Software Getting Started Guide
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5. Select the file type in the List Files of type field.
6. Click on Save.
MC Next displays the Receive dialog.
Review the currently selected total station and communication settings. If
the settings are not correct, see Setting Communication Parameters.
If the total station is a...

Then set...

Sokkia SET500 / 600 or SET5F / 6F

the Checksum option to No and the Xon/Xoff option
to Yes.

Topcon GTS200 GPS3000 Series or

Make sure you send one job at a time and send
data in POS view or coordinates.
the Protocol option to One Way.
You must send coordinates or points only.

Topcon GTS500 / 600 / 700 / 800
Series or FC6 / FC6A

the Protocol option to Xon/Xoff.
You must send coordinates or points only.

7. Click on Open Port.
8. The message Waiting to receive appears, indicating that you should prepare
the device for transferring a file.
9. The device sends the selected data to MC Next. During transmission, a
screen displays on the device, indicating the number of records that are
being sent.
10. When the transfer is complete, click on Close Port.
11. To save the received file, click Save.
Once the file is saved, a message asks if you want to add the received file to the
current database. To add the file to the current database, click Open. If you do not
want to add the received file, click Cancel.

Sending data to a mobile device
1. Connect the mobile device to the computer using Microsoft ActiveSync
technology. For more information on ActiveSync, refer to the
documentation for the mobile device.
2. From the Ribbon, select Export to Device.
The Export to mobile device dialog appears.
3. Check the groups to export and then click Next.
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4. Enter a name for the file that you will export.
5. If you have created a background file in your CAD software, select the
Include background file check box.
6. Click Explore or Explore Project Folder to start exchanging files.

Sending data to a total station
1. Connect the Total Station to the computer.
2. From the Ribbon, select Export to Device.
The Export to Device Dialog appears.
3. Check the groups to export and then click Next.
Review the currently selected total station and communication settings. If
the settings are not correct, see Setting Communication Parameters.
If the total station is a...

Then set...

Sokkia SET500 / 600 or SET5F / 6F

the Checksum option to No and the Xon/Xoff option
to Yes.

Topcon GTS200 GPS3000 Series or

Make sure you send one job at a time and send
data in POS view or coordinates.
the Protocol option to One Way.
You must send coordinates or points only.

Topcon GTS500 / 600 / 700 / 800
Series or FC6 / FC6A

the Protocol option to Xon/Xoff.
You must send coordinates or points only.

4. Prepare the total station to accept incoming data. For more information, refer
to the user documentation provided with your total station.
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5. When the device is ready, on the computer click Send Now.
The MC Next software sends the current database to the device. During
transmission, a screen displays on the device, indicating the number of
records being received.
6. When the transfer is complete, click OK.
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6 Working with CAD Data
This chapter describes how to insert points such as intersections of gridlines or
foundation piles in your CAD drawing for setting-out purposes. It also describes
how to import features from and export features to CAD files.

Setting up your CAD environment
When you launch your CAD software from within the MC Next software, the CAD
software automatically displays the tools you need to work with the MC Next
software.
To set up the MC Next software so that it starts the correct CAD software:
1. Start the MC Next software, if you have not already done so. To do this,
from the Windows Start menu select Programs / MC Next.
2. From the Ribbon Quick Access Toolbar at the top of the screen, select
Settings.
The dialog Settings appears.
3. Select the CAD / BIM Program tab:

4. Click the Browse button

MC Next Software Getting Started Guide
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5. Open the folder where your CAD program is located (for example
c:\Program Files\Autodesk\AutoCAD 2016) and then click the executable
file (for example acad.exe) to select it.
6. Click Open.
7. Click OK to apply these settings and close the Settings dialog.
To start your CAD software from within the MC Next software, select Prepare
points in CAD / Revit from the Ribbon.
The CAD software automatically starts and displays the MC Next toolbar:

To open a CAD drawing, select File / Open in the CAD software.
If you have not already set the settings for drawings in the CAD Program tab of the
Settings dialog in the MC Next software, you should do this the first time you open
a CAD drawing for use with the MC Next software.
1. To do this, click the Settings button

on the MC Next toolbar.

The Settings dialog appears:

2. Make your changes and then click OK.
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Inserting points in a CAD drawing
Insert points in a CAD drawing for setting-out purposes. For example, insert points
such as the intersections of gridlines or foundation piles.
1. Click the Insert Points button

on the MC Next toolbar.

Note – The position of the inserted points depends on the current Osnap
settings, which means that the position of a point is for example "exactly"
the intersection of two lines or the insertion point of a block. To review the
current osnap settings enter the command OSNAP in the command line of
the CAD software, or use the statusbar of the CAD software.
2. Insert the points for stake out. The point number is inserted automatically.
3. When you have finished adding points, press [Esc].
Auto Insert Points Over Blocks

The Auto insert Points over Blocks wizard allows you to automatically place points
on top of existing Blocks. This can be practical for e.g. foundation piles or anchors
for prefabricated walls: you let MC Next know the Block name – by clicking on a
block symbol – and MC Next automatically places points on top of the block
symbols with in case of foundation piles adoption of the pile number. This way you
generate hundreds of points with only a few mouse clicks.

1. Click the Auto Insert Points over Blocks button

on the MC Next toolbar.

The message Select a block appears.
2. Click on a Block in the drawing.
The message Select objects appears.
MC Next Software Getting Started Guide
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3. In the drawing, drag a rectangular window around the area to use for the
Auto Insert Points over Blocks wizard and then press [Enter].
The wizard Auto Insert Points over Blocks appears.
4. Follow the instructions in the wizard and then press Finish.
5. Click the Update Drawing button to insert the points in the current drawing.
Auto Insert Points Over Lines

The Auto insert Points over Lines wizard allows you to superimpose points over the
intersections (2D) or endpoints (3D) of lines. This can be practical for e.g. grid lines
or a foundation plan: you let MC Next know the layer name – by clicking on a line
or polyline – and MC Next automatically places points over these lines.

1. Click the Auto Insert Points over Lines button

on the MC Next toolbar.

The message Select a line appears on the screen.
2. Click on a Line in the drawing.
The message Select objects appears.
3. In the drawing, drag a rectangular window around the area to use for the
Auto Insert Points over Lines wizard and then press [Enter].
The wizard Auto Insert Points over Lines appears.
4. Follow the instructions in the wizard and then press Finish.
5. Click the Update Drawing button to insert the points in the current drawing.
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Auto Insert Points Over Circles or Points

The Auto insert Points over Circles or Points wizard allows you to automatically
place points on top of existing ‘Circles’. This can be practical for e.g. foundation
piles or anchors for prefabricated walls: you let MC Next know the Layer name – by
clicking on a circle or point symbol – and MC Next automatically places points on
top of these circles or points. This way you generate hundreds of points with only a
few mouse clicks.

1. Click the Auto Insert Points over Circles or Points button
Next toolbar.

on the MC

The message Select a circle or point appears.
2. Click on a Circle or Point in the drawing.
The message Select objects appears.
3. In the drawing, drag a rectangular window around the area to use for the
Auto Insert Points over Circles or Points wizard and then press [Enter].
The wizard Auto Insert over Points Objects appears.
4. Follow the instructions in the wizard and then press Finish.
5. Click the Update Drawing button to insert the points in the current drawing.
Coordinate System

The Coordinate System wizard will help you to define a new coordinate system by
specifying two base points (A & B) in the drawing. These two points will represent
your new coordinate system (MCS) without changing the drawing.
For example: Point A is new origin (0,0,0) and Point B is the new +X-Axis
direction.
MC Next Software Getting Started Guide
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All setting out lists – including lists with polar correlations – are always based on
coordinates. All points in a CAD drawing already have coordinates (WCS) but the
axes are often chosen arbitrarily. This may mean that where 2 gridlines intersect the
coordinates in the pile plan have different values to those in the foundation drawing!
MC Next offers you a simple and unambiguous way of defining the Coordinate
System for all the drawings within a particular project.

1. Click the Define Coordinate System button

on the MC Next toolbar.

The Coordinate System Wizard appears. You can define a new Coordinate
System by specifying two base points (A & B) in the drawing.
2. Follow the instructions in the wizard and then press Finish.
3. Click the Update Drawing button to insert the two base points in the current
drawing.

Exporting from CAD to the MC Next software
Use the MC Next toolbar in your CAD software to export points and backgrounds.
Exporting points to MC Next

To export points to the MC Next software, click the Export Points button
MC Next toolbar.

on the

The points are loaded into MC Next. You can edit the points or send it to a mobile
device or total station. For more information, see Communicating with Devices.
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Exporting a background file and points to MC Next

When you use a Windows Mobile device, you can export a background file in DXF
format, together with your points.
Tip – To reduce the file size of background files, we recommends you first use the
LAYISO command in the CAD software to easily isolate layers you need for the
background file. To use this LAYISO command, enter LAYISO in the command line
of the CAD software and then use your mouse to select the entities to include in the
background file and then press Enter.
1. On the MC Next toolbar, click the arrow on the Export Points button
and
then click the Export Background File & Points button
on the pullout
menu.
The message Select objects for background file appears.
2. In the drawing, drag a rectangular window around the area to include in the
background file and then press [Enter].
The message Background file is created appears. The points are now
exported to the MC Next software.
You can now send the points to a mobile device. For more information, see
Sending data to a mobile device.
3. To return to the original state of your drawing in the CAD software, enter
LAYUNISO in the command line of the CAD software.

Importing files into the MC Next software
You can import standard ASCII formats, such as Comma- and Tab delimited files,
into the MC Next software. You can also import DXF- or DXX files for setting-out
purposes.
1. From the Ribbon, choose Import from file.
The dialog Import from file appears.
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2. Select the type of file to import.
3. Follow the instructions in the wizard and then click Import.
Importing blocks from a DXF file

You can import blocks with or without attributes or import points (entity POINT)
from a CAD drawing for setting out purposes. When importing blocks, you can
select them by name or by selecting all blocks in the drawing that have a particular
tag.
Normally you can use the insertion point of a block and the value stored in the tag.
For example, a design point is displayed as follows in a CAD drawing:
1
DP

Here a block with the name "DP1" has two linked attributes, "Pointnumber" and
"Code". The value "1" is stored in the tag "Pointnumber" and the value "DP" is
stored in the tag "Code". To create a coordinate record, the MC Next software uses
the insertion point of the block as the X- and Y-coordinate and the value stored in
the tag as the point number.
You can also import blocks without attributes from a CAD drawing. The MC Next
software uses the insertion point of the block as the X- and Y-coordinate and
numbers the blocks in random order.
Note – The MC Next software can export a DXF file for you to print the numbering
on the original CAD drawing. For more information, see Exporting to a file.
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Importing design points from a DXF or DXX file

1. From the Ribbon, choose Import from file.
The Import from File dialog appears.
2. Select the DXF Files (*.dxf) option and then click Next.
3. Click the Browse button

to select a file.

Note – To open a DXX file, select the file type in the List Files of Type field.
A DXX file contains only blocks and attribute information and is therefore
much smaller in file size.
4. To open the file, double-click it.
The Import from File dialog lists the entities found in the file:

5. Select the CAD data to import by clicking the box next to the appropriate
symbol. Remember to check each tab. For more information, see Selecting
CAD data and establishing settings below.
6. To add the points to the MC Next software, click Import.
Selecting CAD data and establishing settings
Blocks and Attributes tab
The Blocks and Attributes tab displays the information for each block in four
columns. The first two columns display the name and tag of the user block. The
Count column the number of blocks that exist in the CAD drawing with that
particular name and tag, and the Valid Count column displays the number of
blocks that are valid. A block is invalid if the attribute (tag) contains no value.
You cannot select invalid blocks.
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Blocks tab
The Blocks tab displays only the blocks – it does not show attributes. You can
easily select the blocks you want by clicking the box near the symbol. You can
also select a start number and increment for the blocks.
Points tab
The Points tab enables you to select the points by layer that you want to import
from the CAD drawing.

Exporting from the MC Next software
You can export data from MC Next as Total Station files, DXF files, or to standard
ASCII file formats, such as comma separated (.csv) or tab delimited (.txt) files.
Alternatively, export points directly to your CAD software. You can export points
to a new drawing or to an existing drawing.
Exporting to a file

1. From the Ribbon, choose Export to file.
The dialog Export to file appears.

2. Select the file type that you want to export data to.
3. Follow the instructions in the wizard and then click Export.
Exporting to the CAD software

1. From the Ribbon, choose Export to CAD / Revit.
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The dialog Export to CAD appears.

2. Select the Export points to a new drawing option or the Export points to an
existing drawing option.
3. Follow the instructions in the wizard and then click Export.

Generating Reports
Use the Generate Report option in the MC Next software to obtain detailed inverse
information for setting out or other field operations.
1. From the Ribbon, select Generate Report.
The dialog Generate Reports appears.

2. Select the Generate Coordinate List option to generate coordinates for each
point or the Inverse Report option to include angle and distance data as well
as coordinates for each point.
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3. Follow the instructions in the wizard and then click Generate.
Note – You can sort the list by any column. To do this, click the column
header for the column you want to sort by.

Generating Deviation Report
The Deviations Wizard will help you to compare measured points with the original
design points in the drawing. You can report and display the deviations in the
drawing by following a few simple steps.
The Point Comparison is designed for use as an assistance in Quality Control (Asbuilt) surveys.
1. From the Ribbon, select Generate Deviation Report.
The Deviations Wizard appears.

2. Follow the instructions in the wizard and then click Export.
Select the measured points for the point comparison and a CAD file which
contains the design points. MC Next will launch your CAD program and
opens automatically the selected CAD File. When the CAD drawing is
loaded, the wizard will be continued and you can specify how you would
like to compare the measured points with the original design points.
3. Click the Update Drawing button to insert the deviations in the current
drawing.
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Generating Profile
The Generate Profile Wizard will help you to generate long and cross-sections to
export to a CAD drawing.
The wizard is designed for use as an assistance in roading development, river
control, and any other activity where accurate sections are required. You can define
and export the profiles to a drawing by following a few simple steps.
1. From the Ribbon, select Generate Profile.
The Generate Profile Wizard appears.

2. Follow the instructions in the wizard and then click Export.
Your CAD software starts and automatically opens the CAD drawing
showing the profiles.

Generating Surface and Calculate Volume
To calculate enclosed volumes of digital terrain models (DTM), use the Calculate
Volume Wizard in the MC Next software.
The wizard is designed for use as an assistance in stockpile calculations and
monitoring the filling of refuse pits and other such areas. You can report the
calculation results and export the DTM to a drawing by following a few simple
steps.
1. From the Ribbon, select Generate Surface and Calculate Volume.
The Calculate Volume Wizard appears.
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2. Follow the instructions in the wizard and then click Export.
To add a selection of points to the DTM, specify an enclosed boundary.
Points outside the boundary are not added to the DTM. When the DTM is
created, you can review the results of the volume calculation and export the
DTM to a CAD drawing.
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This chapter describes how to insert points such as intersections of gridlines or
foundation piles in your Revit project for setting-out purposes. It also describes how
to import features from and export features to Revit files.

Setting up your Revit environment
When you launch your Revit software from within the MC Next software, the Revit
software automatically displays the tools you need to work with the MC Next
software.
To set up the MC Next software so that it starts the correct Revit software:
1. Start the MC Next software, if you have not already done so. To do this,
from the Windows Start menu select Programs / MC Next.
2. From the Ribbon Quick Access Toolbar at the top of the screen, select
Settings.
The dialog Settings appears.
3. Select the CAD / BIM Program tab:

4. Click the Browse button

next to the Use Program drop-down list.

5. Open the folder where your Revit program is located (for example
c:\Program Files\Autodesk\Revit 2016) and then click the executable file
(for example Revit.exe) to select it.
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6. Click Open.
7. Click OK to apply these settings and close the Settings dialog.
To start your Revit software from within the MC Next software, select Prepare
points in CAD / Revit from the Ribbon.
The Revit software automatically starts and displays the MC Next toolbar:

To open a Revit project, select File / Open in the Revit software.
If you have not already set the settings for projects in the CAD / BIM Program tab
of the Settings dialog in the MC Next software, you should do this the first time you
open a Revit project for use with the MC Next software.
1. To do this, click the Settings button

on the MC Next toolbar.

The Settings dialog appears:

2. Make your changes and then click OK.
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Inserting points in a Revit project
Insert points in a Revit project for setting-out purposes. For example, insert points
such as the intersections of gridlines or foundation piles.
1. Click the Insert Points button

on the MC Next toolbar.

Note – The position of the inserted points depends on the current Snap
settings, which means that the position of a point is for example "exactly"
the intersection of two lines. To review the current snap settings go to the
Manage tab and then click SNAPS.
2. Insert the points for stake out. The point number is inserted automatically.
3. When you have finished adding points, press [Esc] twice.
Auto Insert Points Over Families

The Auto insert Points over Families wizard allows you to automatically place
points on top of existing Families. This can be practical for e.g. pilecaps or columns:
you let MC Next know the family name – by clicking on a family – and MC Next
automatically places points on top of the families. This way you generate hundreds
of points with only a few mouse clicks.

1. Click the Auto Insert Points over Families button on the MC Next toolbar.
2. Click on a Family in the document.
The selected family will be isolated.
3. Insert the points for stake out. The point number is inserted automatically.
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4. When you have finished adding points, press [Esc] twice.
The wizard Auto Insert Points over Families appears.
5. Follow the instructions in the wizard and then press Finish.
6. The points will automatically be added to the document.
Auto Insert Points Over Geometry

The Auto insert Points over Geometry wizard allows you to automatically place
points over non-repeating geometry. This can be practical for e.g. columns or floors:
you let MC Next know the elements – by selecting multiple elements – and MC
Next automatically places points over these elements.

1. Click the Auto Insert Points over Geometry button on the MC Next toolbar.
The message Select multiple elements appears on the screen.

2. In the document, select the elements to use for the Auto Insert Points over
Geometry Wizard and then press Finish.
The wizard Auto Insert Points over Geometry appears.
3. Follow the instructions in the wizard and then press Finish.
4. The points will automatically be added to the document.
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Auto Insert Points Over Grid

The Auto insert Points over Grid wizard allows you to superimpose points over the
intersections of grid lines.

1. Click the Auto Insert Points over Grid button on the MC Next toolbar.
The wizard Auto Insert over Grid appears.
2. Follow the instructions in the wizard and then press Finish.
3. The points will automatically be added to the document.

Adding point tags in a Revit project
To add point tags to the points in a Revit project, select a plan view from the Project
Browser and then click the Tag Points button on the MC Next toolbar.
The points are now being tagged with a point number.

Exporting from Revit to the MC Next software
Use the MC Next toolbar in your Revit software to export points and backgrounds.
Exporting points to MC Next

To export points to the MC Next software, click the Export Points button
MC Next toolbar.
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The points are loaded into MC Next. You can edit the points or send it to a mobile
device or total station. For more information, see Communicating with Devices.
Exporting a background file and points to MC Next

When you use a Windows Mobile device, you can export a background file in DXF
format, together with your points.
1. Select a view to include in the background file, if you have not already done
so. To do this, select a view from the project browser.
2. On the MC Next toolbar, click the arrow on the Export Points button
and
then click the Export Background & Points button
on the pullout menu.
The points are now exported to the MC Next software and the background
file is created.
You can now send the background and the points to a mobile device. For
more information, see Sending data to a mobile device.

Exporting to the Revit software
1. From the Ribbon, select Export to CAD / Revit.
The dialog Export to CAD / Revit appears.
2. Check the groups to export and then click Export.
In Revit, the message Import is ready appears.

3. Choose Yes to import the points into the current project or choose No to
cancel. You can always import the points later by selecting the Update
Project button in the Ribbon.
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Generate Deviations
The Deviations Wizard will help you to compare measured points with the original
design points in the document. You can report and display the deviations in the
document by following a few simple steps.
The Point Comparison is designed for use as an assistance in Quality Control (Asbuilt) surveys.
1. From the Ribbon, select Generate Deviation Report.
The Deviations Wizard appears.

2. Follow the instructions in the wizard.
The wizard allows you to select the measured points to be used in the point
comparison and a Point Group or Revit document which contains the design
points. Select From Group to compare two groups of points or select From
Revit Document to generate deviations in the Revit document.

MC Next Software Getting Started Guide

49

7 Working with Revit Data

MC Next Software Getting Started Guide

50

A Tutorial
This tutorial has lessons about settings, importing and exporting files, preparing
points in a CAD drawing, generating reports and calculating volumes.
You can work through these lessons sequentially, or you can do one lesson at a
time. However, within each lesson you should complete the exercises in the order
presented, as the first exercises provide you with the information you need for the
later exercises in that lesson.

Before you begin
Each lesson, except for the first one, has a tutorial drawing and/or data file.
Note – Working through these lessons will result in alteration of the example files.
Backup copies of these example files can be found in the \Program Files\MOUS
Software\MC Next <Version Number>\Tutorial folder.
If a lesson has been previously run, copy these unaltered example files to the
\Documents\MC Next <Version Number> Tutorial folder when starting a new
tutorial session to ensure that the sequence outlined in each lesson can be properly
followed.

Lesson 1: Apply settings
Applying general software settings

In this exercise, you will select the units and a CAD program for MC Next. To work
through this lesson follow these steps:
1.

Start the MC Next software, if you have not already done so. To do this,
from the Windows Start menu select Programs / MC Next.

2.

From the Ribbon Quick Access Toolbar at the top of the screen, select
Settings.
The Settings dialog appears.

3.

Select the Units tab:
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4.

Select the following settings:
 Coordinate Order: X-Y-Z / E-N-Elev
 Distance: Meters
 Angle: Gon
These units will now be the standard units that MC Next uses for your
projects.

5.

Select the CAD / BIM Program tab:

6. Click the Browse button
MC Next Software Getting Started Guide
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7.

Open the folder where your CAD program is located (for example
c:\Program Files\Autodesk\AutoCAD 2016) and then click the executable
file (for example acad.exe) to select it.

8.

Click Open.

9.

Click OK to apply these settings and close the Settings dialog.

Applying total station communication settings

In this exercise, you will select the total station and settings that the MC Next
software will use.
1. From the Ribbon Quick Access Toolbar at the top of the screen, select
Device Settings.
The Communication Settings dialog appears:

2. In the Communication Device drop-down list, select your total station.
3. Select the appropriate settings for port, baud rate, data bits and stop bit.
Note – The MC Next software must be set to the same baud rate and parity
as the device for data transmission to work correctly.
4. Click OK to apply these settings and close the dialog.
This concludes the Apply Settings lesson. In the next lesson, you'll learn how to
import and export files.
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Lesson 2: Import and export files
Importing a file

In this exercise, you will learn how to import a file.
1. Start the MC Next software, if you have not already done so.
2. From the Ribbon, select Import from File.
The Import from File wizard appears:

3. Select the ASCII files option and then click Next.
4. Click the Browse button
and then navigate to the \ Documents \ MC
Next <Version Number> Tutorial \ MC Example Project Meters folder.
Select the file 4_Terrain_MCS.txt.
5. Click Open.
6. Click Import.
The file is imported into the MC Next software. Notice that the contents of the file
is displayed in both the ListView and the GraphicView.
Tip – You can also import files by dragging them from your local hard drive and
dropping them into the MC Next software window.
Exporting files to CAD

In this exercise, you will learn how to export a file to your CAD program.
1. From the Ribbon, select Export to CAD / Revit.
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The Export to CAD wizard appears:

2. Select the Export points to a new drawing option and then click Next.
3. Select group 4_Terrain_MCS and then click Next.
4. Select the units. For Units (XY) and Units (Z), select Meters.
5. Click Details.
6. For the Annotation Type option, select PointID + Code.
7. Click Next.
8. Select the Draw Polyline between continuous range of points option and
then click Next.
9. Select the With coordinates as measured option and then click Export.
Your CAD software starts and automatically opens the CAD drawing you have just
exported.
Note – Notice that point 3001 and 3002 are measured as reference points, which
will be used in lesson 4 to position the design drawing.
Exporting control points only file

In this exercise, you will learn how to export a file that contains only control points.
1. Return to the MC Next software, if you have not already done so.
2. In the ListView of the MC Next software, select the points to export. Press
and hold the [Shift] key as you click the left mouse button on point 9000 and
then click the left mouse button on point 9050.
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The points 9000 to 9050 are now selected.
3. From the Ribbon, select Copy.
The points 9000 to 9050 are saved to the clipboard.
4. From the Ribbon Application Menubar at the top of the screen, select New.
5. From the Ribbon, select Paste.
The control points 9000 to 9050 are added to the new group.
6. From the Ribbon, select Export to File.
The Export to File wizard appears.
7. Select the ASCII files option and then click Next.
8. Select the new group and then click Next.
9. Click the Browse button
and then navigate to the \ Documents \ MC
Next <Version Number> Tutorial \ MC Example Project Meters folder.
Enter the file name ControlPoints.txt.
10. Click Save.
11. Click Export.
The file is exported.
Note – The file ControlPoints.txt will be added to a project in lesson 5.
This concludes the Import and Export Files lesson. In the next lesson, you'll learn
how to prepare points in a CAD drawing.
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Lesson 3: Prepare points in a CAD drawing
In this lesson, you will familiarise yourself with terms commonly used in CAD
drawings and learn how to prepare points in a CAD drawing.
Understanding terms used in a CAD drawing

The table below defines some of the terms that the MC Next software uses when
referring to CAD drawings:
Term

Definition

Attribute

An Attribute depence on a User block. You can see it as a label linked with a User
block, which contains information of that User block. A
"Pointnumber" or "Code" are examples of attributes. They are giving information of
the User block. An attribute is always displayed as text.
A block (or User block) is a group of entities. For example a symbol, which can
contains a number of lines.

Block
CSV

A CSV file is a Comma Separated Value File. A CSV file is a text file and contains per
line information of a point separated with a comma sign.
For example: PointID, X, Y, Z, Code
The DXF format is a standard Drawing eXchange Format for CAD drawings. You can
easily save a CAD drawing as a DXF file in your CAD application.

DXF

DXX

The DXX format is a Attribute Information format. You can save a CAD drawing as a
DXX file. A DXX file contains only information of User blocks with attributes in a CAD
drawing, and is therefore much smaller in file size than a DXF file.

Entity

A entity is a single object in a CAD drawing. For example a line, circle or text.

Insertion point

The insertion point of a User block is the base point of a User block, which you are
using to insert the User block in a CAD drawing

Tag

A Tag is the name of the attribute. For example "Pointnumber" or "Code".

TXT

A TXT file is a Tab Delimited File. A TXT file is a text file and contains per line
information of a point separated with a tab sign.
For example: PointID X Y Z Code

Inserting points in a CAD drawing

1. Start the MC Next software, if you have not already done so.
2. From the Ribbon at the top of the screen, select Prepare Points in CAD /
Revit.
Your CAD software automatically starts and displays the MC Next toolbar.
3. In the CAD software, select File / Open and then navigate to the \
Documents \ MC Next <Version Number> Tutorial \ MC Example Project
Meters folder. Select the file MC_Example_clean.dwg.
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4. When the CAD drawing opens, click the Settings button
toolbar.

on the MC Next

The Settings dialog appears:

a.

In the Drawing Units drop-down list, select Meters.

b.

In the New Group field, enter Foundation and then click Add.

c.

In the Start Number field, enter 501.

d.

Click OK to apply these settings.

If you are using AutoCAD LT, click the Update Drawing button on the MC
Next toolbar to save these settings in the drawing.
5. In the command line of your CAD software, enter OSNAP. For the snap
function, select Intersection and then click OK.
Tip – The position of the inserted points depends on your current OSNAP
settings, which means that the position of a point is for example "exactly"
the intersection of two lines or the insertion point of a block. To review the
current OSNAP settings, enter the command OSNAP in the command line of
the CAD software, or use the status bar of the CAD software. Make sure
that the Object Snap is on.
6. On the MC Next toolbar, click the Insert Points button
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7. With your left mouse button, click one of the outside corners of the
extension foundation at the left of the drawing and then click again to
position the point number.
Note – The snap function activates as you approach the intersection with
the mouse cursor. Make sure you zoom in far enough to visually see the
snap position of the point.

8. Click each of the remaining points on the outside corners of the foundation.
9. When you have finished selecting the points, press [Esc].
10. From the File menu of your CAD software, select Save to save the current
drawing.
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Auto Insert Points over Blocks

In this exercise, you will learn how to automatically insert points over blocks in a
CAD drawing for setting out purposes.
1.

Click the Auto Insert Points over Blocks button
toolbar.

on the MC Next

The message Select a block appears.
2.

Click on a foundation pile (= Block) from the main building in the
drawing.
The message Select objects appears.

3.

In the drawing, drag a rectangular window around the area to use for the
Auto Insert Points over Blocks wizard and then press [Enter]. For now,
select the entire drawing.
The wizard Auto Insert Points over Blocks appears on the screen.

4.

Click Next and select the By Tag option to number the blocks. Click Next
to continue.

5.

Click the Select all blocks with current Tag button to select all foundation
piles and then click Next.

6.

In the New Group field, enter Piles, click Add and then click Next.

7.

Review the settings for the points and click Next.

8.

Select for invalid numbers the Skip option and then click Next.

9.

A summary of the points will be displayed. Review the points and then
click Next.
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10. Click Finish to close the wizard.
11. Click the Update drawing button
points in the current drawing.

on the MC Next toolbar to insert the

12. From the File menu of your CAD software, select Save to save the current
drawing.
Auto Insert Points over Lines

In this exercise, you will learn how to automatically insert points over lines in a
CAD drawing for setting out purposes.
1. Click the Auto Insert Points over Lines button

on the MC Next toolbar.

The message Select a line appears.
2. Click on a grid line from the main building in the drawing.
The message Select objects appears.
3. In the drawing, drag a rectangular window around the area to use for the
Auto Insert Points over Lines wizard and then press [Enter]. For now, select
the main building.
The wizard Auto Insert Points over Lines appears.

4. Click Next and select the Intersections (2D) option. In the Start number
field, enter 1001 and then click Next.
5. Select layer GRID-LINES-25 and then click Next.
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6. In the New Group field, enter Grid, click Add and then click Next.
7. Review the settings for the points and click Next.
8. Select the first option for Number Route and then click Next.
9. A summary of the points will be displayed. Review the points and then
click Next.
10. Click Finish to close the wizard.
11. Click the Update drawing button
points in the current drawing.

on the MC Next toolbar to insert the

12. From the File menu, choose Save in your CAD program to save the current
drawing.
Auto Insert Points over Circles or Points

In this exercise, you will learn how to automatically insert points over circles and
points in a CAD drawing for setting out purposes.
1. Click the Auto Insert Points over Circles or Points button
Next toolbar.

on the MC

The message Select a circle or point appears.
2. Click on a foundation pile (= Circle) at the left of the drawing (extension,
not the main building).
The message Select objects appears.
3. In the drawing, drag a rectangular window around the area to use for the
Auto Insert Points over Circles or Points wizard and then press [Enter].
Select the extension, not the main building.
The wizard Auto Insert Points over Circles or Points appears.
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4. Click Next. Select the By searching for text within radius option and then
click Next.
5. Select layer PILES-CIRCLES and then click Next.
6. From the Groups list, select Piles and then click Next.
7. For the position of the Point Number, select the second quadrant. In the
Shift Number: +/- field, enter 200 and then click Next.
8. For invalid numbers, select the Assign number option and then click Next.
9. A summary of the points will be displayed. Review the points and then
click Next.
10. Click Finish to close the wizard.
11. Click the Update drawing button
points in the current drawing.

on the MC Next toolbar to insert the

In the following steps you will learn how to split polylines from the ROADLINES layer into segments of 2 meters for setting out purposes.
12. Make layer ROAD_LINES “current” by clicking on the layer in the layer
list.
13. On the command line, enter MEASURE and then press [Enter].
The message Select object to measure appears.
14. Click one of the polylines from the ROAD_LINES layer.
The message Specify length of segment or [Block] appears.
15. Enter 2 and then press [Enter].
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Notice that the polyline is split into segments of 2 meters. The marked
points are POINT entities.
16. Now repeat step 13, 14 and 15 to split the two remaining polylines from the
ROAD_LINES layer.
17. Click the Auto Insert Points over Circles or Points button
Next toolbar.

on the MC

The message Select a circle or point appears.
18. Click on one of the marked points (entity point).
The message Select objects appears.
19. In the drawing, drag a rectangular window around the area to use for the
Auto Insert Points over Circles or Points wizard and then press [Enter]. For
now, select the entire drawing.
The wizard Auto Insert Points over Circles or Points appears.
20. Click Next and select the By Startnumber option. In the Start number field,
enter 2001 and then click Next.
21. Select layer ROAD_LINES and then click Next.
22. In the New Group field, enter Road, click Add and then click Next.
23. Review the settings for the points and click Next.
24. Select for Number Route the None (by creation order) option and then click
Next.
25. A summary of the points will be displayed. Review the points and click
Next.
26. Click Finish to close the wizard.
27. Click the Update drawing button
points in the current drawing.

on the MC Next toolbar to insert the

28. From the File menu, choose Save in your CAD program to save the current
drawing.
This concludes the Prepare Points in CAD drawing lesson. In the next lesson, you'll
learn how to define a new coordinate system in a CAD drawing.
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Lesson 4: Define a Coordinate System
In this exercise, you will learn how to define a new Coordinate System (MCS) in a
CAD drawing.
To work through this lesson follow these steps
1. Start the MC Next software, if you have not already done so.
2. From the Ribbon at the top of the screen, select Prepare Points in CAD /
Revit.
Your CAD software automatically starts and displays the MC Next toolbar.
3. In the CAD software, select File / Open and then navigate to the \
Documents \ MC Next <Version Number> Tutorial \ MC Example Project
Meters folder. Select the file MC_Example_WCS.dwg.
4. When the CAD drawing opens, click the Define Coordinate System button
on the MC Next toolbar.
The Coordinate System Wizard appears.

5. Click Next. Select the Advanced… option and then click Next.
6. From the Groups drop-down list, select Grid. Select point 1001 and then
click the = Point A button.
Note – We will give Point 1001 the coordinates from point 3001 that is used
in lesson 2 – file: 4_Terrain_MCS.txt. We will give Point 1011 the
coordinates from point 3002. Point 3001 and 3002 are measured outside in
the field as reference points and represent the two intersection of gridlines.
We will use these points to position the design drawing.
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7. In the New X in CAD: field, enter 202328.928 (= meters). In the New Y in
CAD: field, enter 439451.684.
8. Select point 1011 and then click the = Point B button.
9. In the New X in CAD: field, enter 202330.319 (= meters). In the New Y in
CAD: field, enter 439487.662 and then click Next.
10. A summary of the coordinate system will be displayed. Review the data and
click Next.
11. Click Finish to close the wizard.
12. Click the Update drawing button
on the MC Next toolbar to insert the
two base points in the current drawing.
13. From the File menu, choose Save in your CAD program to save the current
drawing.
This concludes the Define a Coordinate System lesson. In the next lesson, you'll
learn how to export inserted points to the MC Next software and then send it to your
mobile device or Total Station.
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Lesson 5: Export points to a device
In this exercise, you will learn how to export points from your CAD software to the
MC Next software and then send them to your Mobile Device or Total Station.
Export Points from the CAD software

1. Start the MC Next software, if you have not already done so.
2. From the Ribbon at the top of the screen, select Prepare Points in CAD /
Revit.
Your CAD software automatically starts and displays the MC Next toolbar.
3. In the CAD software, select File / Open and then navigate to the \
Documents \ MC Next <Version Number> Tutorial \ MC Example Project
Meters folder. Select the file MC_Example_MCS.dwg
4. When the CAD drawing opens, click the Export Points button
MC Next toolbar.

on the

The points will be loaded into the MC Next software. You can now send the
points to a Mobile Device or Total Station.
Export Background File and Points

When you use a Windows Mobile Device, you can export a background file in DXF
format, together with your points.
Tip – To reduce the file size of background files, we recommends you first use the
LAYISO command in the CAD software to easily isolate layers you need for the
background file. To use this LAYISO command, enter LAYISO in the command line
of the CAD software and then use your mouse to select the entities to include in the
background file and then press [Enter].
1. Return to the CAD software, if you have not already done so.
2. On the MC Next toolbar, click the arrow on the Export Points button
and
then click the Export Background File & Points button
on the pullout
menu.
The message Select objects for background file appears.
3. In the drawing, drag a rectangular window around the area to include in the
background file. For now, select the entire drawing.
4. Press [Enter].
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The message Background file is created appears. The points are now
exported to the MC Next software.
To return to the original state of your drawing in the CAD software, enter
LAYUNISO in the command line of the CAD software.
You can now send the points to a mobile device.
Export to Mobile Device

In this exercise, you will learn how to export points and a background file to a
mobile device.
1. Return to the MC Next software, if you have not already done so.
2. Connect the mobile device to the computer, using Microsoft ActiveSync
technology. For more information on ActiveSync, refer to the
documentation for the mobile device.
3. From the Ribbon, select Export to Device.
The Export to Device dialog appears.
4. Check the groups to export.
5. Click the Add File… button and then navigate to the \ Documents \ MC Next
<Version Number> Tutorial \ MC Example Project Meters folder. Select the
file ControlPoints.txt and then click Open.
6. Click Next and enter a name for the file that you want export.

7. If you have created a background file in your CAD software, select the
Include background file check box.
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8. Click Explore or Explore Project Folder to start exchanging files.
The file(s) are now saved on the clipboard.
9. To store the file(s) to the default folder, select Paste from the Edit menu.
You can also create a new destination folder, if required.
Export to Total Station

In this exercise, you will learn how to export points to a Total Station.
1. Return to the MC Next software, if you have not already done so.
2. Connect the Total Station to the computer.
3. From the Ribbon, select Export to Device.
The Export to Device dialog appears.
4. Check the groups to export.
5. Click the Add File… button and then navigate to the \ Documents \ MC Next
<Version Number> Tutorial \ MC Example Project Meters folder. Select the
file ControlPoints.txt and then click Open.
6. Click Next and prepare the device for transmission.
7. When the device is ready, click Send Now.
The MC Next software sends the points to the device. During transmission,
a screen displays on the device, indicating the number of records being
received.
8. When the transfer is complete, click OK.
This concludes the Export Points to a device lesson. In the next lesson, you'll learn
how to generate Reports.
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Lesson 6: Generating Setting Out Reports
In this exercise, you will learn how to generate a report that lists the coordinates in a
file.
1. Start the MC Next software, if you have not already done so.
2. From the Ribbon, select Import from file.
The Import from file wizard appears.

3. Select the ASCII files (*.txt; *.csv) option and then click Next.
4. Click the Browse button
and then navigate to the \ Documents \ MC
Next <Version Number> Tutorial \ MC Example Project Meters folder.
Select the file 4_Terrain_MCS.txt
5. Click Open.
6. Click Import to import the file into the MC Next software.
7. From the Ribbon, select Generate Reports.
The dialog Generate Reports appears.
8. Select the Generate a Coordinate List option and then click Next.
9. Select group 4_Terrain_MCS and then click Next.
A coordinate list similar then the one below appears:
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10. Click Generate to view the report in the active internet browser for
printing.
This concludes the Generate Reports lesson. In the next lesson, you'll learn how to
generate a Deviation Report and export the deviations to CAD.
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Lesson 7: Generating a deviation report
In this exercise, you will learn how to generate a deviation report and export the
deviations to CAD.
1. Start the MC Next software, if you have not already done so.
2. From the Ribbon, select Import from file.
The Import from file wizard appears.

3. Select the ASCII files (*.txt; *.csv) option and then click Next.
4. Click the Browse button
and then navigate to the \ Documents \ MC
Next <Version Number> Tutorial \ MC Example Project Meters folder.
Select the file 6_Measured_Piles_MCS.txt
5. Click Open.
6. Click Import to import the file into the MC Next software.
7. From the Ribbon, select Generate Deviation Report.
The Deviations wizard appears.
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8. Click Next. Select group 6_Measured_Piles_MCS and then click Next.
9. You can select all measured points or a range of points for the point
comparison. For now, select all measured points and then click Next.
10. Select the From CAD File option. Click the Browse button
and
navigate to the \ Documents \ MC Next <Version Number> Tutorial \ MC
Example Project Meters folder. Select the file MC_Example_MCS.dwg and
then click Open.
11. Click Next.
Your CAD software starts and automatically opens the CAD drawing you
have just selected. When the drawing opens, the Deviations wizard appears.
12. Click Next. Select group Piles (this is the group with the design points) and
then click Next.
13. Verify the settings for the point comparison and then click Next.
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14. Review the results and then click Next.

15. Verify the CAD settings for the deviations and then click Next.
16. Verify the settings for points above tolerance and then click Next.
17. A summary of the point comparison will be displayed. Review the data and
then click Next.
18. Click Finish to close the wizard.
19. Click the Update drawing button
deviations in the current drawing.

on the MC Next toolbar to insert the

20. From the File menu, choose Save in your CAD program to save the current
drawing.
This concludes the Generate a Deviation Report and export to CAD lesson. In the
next lesson, you'll learn how to generate a front view of a façade.

MC Next Software Getting Started Guide

74

A Tutorial

Lesson 8: Generate a front view
In this lesson, you will learn how to generate a front view of a façade and then
export it to your CAD software.
1. Start the MC Next software, if you have not already done so.
2. From the Ribbon, select Import from File.
The Import from File wizard appears:

3. Select the ASCII files option and then click Next.
4. Click the Browse button
and then navigate to the \ Documents \ MC
Next <Version Number> Tutorial \ MC Example Project Meters folder.
Select the file 7_Facade_WCS.txt.
5. Click Open.
6. Click Import to import the file into the MC Next software.
7. From the Ribbon menu, select Export to CAD.
The Export to CAD wizard appears:
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8. Select the Export points to a new drawing option and then click Next.
9. Select group 7_Facade_WCS and then click Next.
10. Select the units. For Units (XY) and Units (Z), select Meters.
11. Click Details.
12. For the Annotation Type option, select PointID + Code. Click Next.
13. Select the Draw Polyline between continuous range of points option and
then click Next.
14. Select the With different axes and/or view option and then click Next.
15. For the alignment of the drawing, select the By 2 points (Origin and +Xaxes direction) option and then click Next.
Note – You can specify a new origin and +X-axes (East direction) for the
survey. In this exercise, the survey will first be positioned on the origin and
X-Axes direction by specifying two points, and then generating a front view.
Point 1 is measured on the facade at the left-bottom corner and Point 2 is
measured on the facade at the right-bottom corner.
16. Select point 1 in the list and then click the button with the arrow for New
Origin.
17. Select point 2 in the list and then click the button with the arrow for New
+X-Axes direction. Click Next.
18. Select the Front View option and then click Export.
Your CAD software starts and automatically opens the CAD drawing you
have just exported.
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This concludes the generate a front view of a facade lesson. In the next lesson, you'll
learn how to generate a DTM of a stockpile and calculate volumes.
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Lesson 9: Generate a DTM and export to CAD
In this lesson, you will learn how to generate a DTM (Digital Terrain Model) of a
stockpile. You will calculate the total volume of the stockpile and then export the
created DTM to your CAD software.
1. Start the MC Next software, if you have not already done so.
2. From the Ribbon, select Import from File.
The Import from File wizard appears:

3. Select the ASCII files option and then click Next.
4. Click the Browse button
and then navigate to the \ Documents \ MC
Next <Version Number> Tutorial \ MC Example Project Meters folder.
Select the file 8_StockPile_WCS.txt.
5. Click Open.
6. Click Import to import the file into MC Next.
7. From the Ribbon, select Generate Surface and calculate Volume.
The Calculate Volume wizard appears:
8. Click Next.
9. Select the first (stockpile) option to calculate volumes and then click Next.
10. Select group 8_StockPile_WCS and then click Next.
11. Select the range of points to use for the DTM. By default, all points are
selected. For this exercise, select all points and then click Next.
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12. Click Define Boundary… and from the selected points list, select Point 1 to
Point 20 (This is the base of the stockpile) as boundary points for the DTM.
Click the right arrow button to add the points to the boundary points list.
Click OK and then click Next.

13. You can define breaklines to adjust the triangle model. For this exercise, we
don’t define any breaklines. Click Next to continue.
14. Click 3D Preview to view the created DTM.
15. Click Close and then Next.
16. Review the results of the volume calculation and then click Next.
17. Verify the contour settings for the DTM and then click Next.
18. Check the CAD settings for the DTM and then click Export.
Your CAD software starts and automatically opens the CAD drawing
showing the DTM of the stockpile.
19. Use the commands SHADE and ORBIT to view the DTM in your CAD
software. For more information, refer to the documentation for your CAD
software.
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B Frequently Asked Questions
This chapter describes the most frequently asked questions with the MC Next
software.

1 The MC Next toolbar in CAD is not displayed
If you want to display the (classic) MC Next toolbar in CAD again, then do the
following;
1. First close your CAD software.
2. Start the MC Next software, if you have not already done so.
3. From the Ribbon Quick Access Toolbar at the top of the screen, select
Settings.
The Settings dialog appears.

4. Select the CAD / BIM Program tab.
5. Click the Advanced button under the Use Program drop-down list.
The Advanced Settings dialog appears.
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6. Uncheck the option Use Ribbon User Interface commands. Press OK and
then OK again.
7. From the Ribbon at the top of the screen, select Prepare points in CAD /
Revit.
Your CAD software automatically starts and the MC Next toolbar should be
visible again in CAD, see screenshot below.

2 Export background file and points in CAD is not working
When Export background file and points in CAD is not working any more than
most likely the CAD drawing file (. dwg) has become damaged or corrupt in some
way. To recover the CAD drawing, follow these steps:
1. Start the MC Next software, if you have not already done so.
2. From the Ribbon at the top of the screen, select Prepare Points in CAD /
Revit.
Your CAD software automatically starts and displays the MC Next toolbar.
3. In the CAD software, select File / Open and then navigate to the damaged
or corrupt drawing file.
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4. When the CAD drawing opens, press [Ctrl + C] (Copy to Clipboard in
CAD).
The message Select objects appears.
5. In the drawing, drag a rectangular window around the area that you want to
copy to the clipboard. For now, select the entire drawing and press [Enter].
6. In the CAD software, select File | New to create a new drawing. Select a
default Template for the drawing (“acadiso.dwt”) and then click Open.
7. When the new CAD drawing opens, right-click and a shortcut menu
appears. From the shortcut menu, select Clipboard and then Paste to
Original Coordinates.

8. On the MC Next toolbar, click the Settings button

.

The Settings window appears:
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9. Select the drawing units and then press OK.
10. On the MC Next toolbar, click the arrow on the Export Points button
and
then click the Export Background File & Points button
on the pull-out
menu.
The message Select objects for background file appears.
11. In the drawing, drag a rectangular window around the area to include in the
background file. For now, select the entire drawing.
12. Press [Enter].
The message Background file is created appears. The points are now
exported to the MC Next software.

If the drawing persists with problems, try the following steps:
1. In the CAD software, select File | Save as.
The Save dialog appears.
a. In the files of type drop-down list, select AutoCAD R12/LT2 DXF
(*.dxf).
b. In the file name field, key in a new name for the drawing.
c. Click Save to save the drawing.
2. Close the drawing.
3. In the CAD software, select File | Open and navigate to the saved DXF file.
4. When the CAD drawing opens, select File | Save As and save the drawing in
DWG file format.
5. On the MC Next toolbar, click the Settings button

.

The Settings window appears.
6. Select the drawing units and then press OK.
7. Export the background file and points again to the MC Next software by
choosing Export background file and Points.
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3 The message “Unable to access Sentinel Run-time
Environment (H0033)” appears
When you launch MC Next, the following message appears on the screen:

To recover the Sentinel Run-time Environment, try the following steps:
1. Reinstall the MC Next software.
Don’t worry, you don’t lose any settings. Download the installation package
from our web site www.moussoftware.com. Choose a location on your
computer to store the setup file, then save and run the .msi file.
The Setup window appears:

2. Select Uninstall and then click Next.
3. Follow the instructions in the wizard and then click Finish.
4. When the MC Next software in uninstalled, launch the .msi file again.
5. The Setup window appears:

MC Next Software Getting Started Guide

85

B Frequently Asked Questions

6. Follow the instructions in the wizard and then click Finish.
Launch MC Next and see if the message appears.
If the message still appears, then try the following steps:
1. Open Windows Explorer and navigate to the folder where your MC Next
program is located (default c:\Program Files (x86)\MOUS Software\MC
Next 2016).
2. Go to the HASP folder and right-click on the file: MCN2016haspdinst.exe
3. From the shortcut menu, select Send to | Desktop (create shortcut).
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A shortcut is created on the desktop.
4. Go to the desktop and right-click on the shortcut icon. From the shortcut
menu, select Properties.
The Properties window appears:

5. In the Target field, key in at the end (after the ”-sign) a space sign and then
-r and then a space sign and then –purge (see screenshot).
6. Click Apply and then click OK.
7. Double click on the shortcut icon to run the executable.
This will remove the Sentinel Run-time Environment. When the Sentinel
Run-time Environment is removed, the following message appears:

8. Right-click again on the shortcut icon. From the shortcut menu, select
Properties.
The Properties window appears:
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9. In the Target field, first delete –r –purge and then key in at the end (after
the ”-sign) a space sign and then –i (see screenshot).
10. Click Apply and then click OK.
11. Double click on the shortcut icon to run the executable.
This will install the Sentinel Run-time Environment. When the Sentinel
Run-time Environment is installed, the following message appears:
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